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ENREAD ME FIRST
READ THIS MANUAL COMPLETELY BEFORE 
ASSEMBLING AND POWERING UP YOUR PRINTER!
HAZARDS AND WARNINGS
The Artillery Sidewinder X2 3D Printer has motorized and heated 
parts. When the printer is in operation, always be aware of possible 
hazards.

ELECTRIC SHOCK HAZARD
Never open the electronics bay of the printer while the printer is 
powered on. Before removing the access panel, always power 
down the printer and unplug the AC power cord.

BURN HAZARD
Never touch the extruder nozzle, the heater block, or the heated bed 
without first turning off the hotend and heated bed and allowing 
it to completely cool down. The hotend and heated bed can take 
up to twenty minutes to completely cool down. Also, never touch 
recently extruded filaments. The filament can stick to your skin and 
cause a burn.

FIRE HAZARD
Never leave flammable materials or liquids on or near the printer when 
powered on or in operation. Liquid acetone and vapors are extremely 
flammable.

PINCH HAZARD
When the printer is in operation, be careful never to put your fingers in 
the moving parts, including the belts, pulleys, gears, wheels, or lead 
screws.

STATIC CHARGE
Make sure to ground yourself before touching the printer, especially the 
electronics. Electrostatic charges can damage electronic components. 
To ground yourself, touch a grounded source.

AGE WARNING
For users under the ages of 18, adult supervision is recommended. 
Beware of choking hazards around children.
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LEGAL
PRODUCT WARRANTY

The Artillery Sidewinder X2 3D Printer is covered by a limited 
warranty. For terms and conditions, see https://desk.zoho.com/
portal/evnovo/en/kb/articles/evnovo-limited-warranty

OVERALL PROVISIONS
All information in this user manual (“Manual”) is subject to 
change at any time without notice and is provided for convenience 
purposes only. Shenzhen Yuntuchuangzhi Technology Co., Ltd. and 
our respective affiliates and suppliers (“Artillery”) reserves the 
right to modify or revise this Manual in its sole discretion and at 
any time and makes no commitment to provide any such changes, 
updates, enhancements, or other additions to this Manual in a 
timely manner or at all. You agree to be bound by any modifications 
and/or revisions. Contact the Artillery Support Team for up-to-date 
information.

INTELLECTUAL PROPERTY
The design of this Manual and all text, graphics, information, content, 
and other material are protected by copyright and other laws. The 
contents are copyright 2021 Artillery. All rights reserved. Certain 
trademarks, trade names, and logos (the “Marks”) used in this 
Manual are registered and unregistered trademarks, trade names 
of Artillery and its affiliates. Nothing contained in this Manual grants 
or should be constructed as granting, by implication, estoppel, or 
otherwise, any license or right to use without the written permission 
of Artillery. Any unauthorized use of any information, materials, or 
Marks may violate copyright laws, trademark laws, laws of privacy 
and publicity, and/or other laws and regulations.
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DISCLAIMERS

Artillery does not warrant the accuracy or completeness of the 
information, products, or services provided by or through this 
Manual and assumes no responsibility for any typographical, 
technical, or other inaccuracies in this Manual, which is provided 
“as is” and without any express or implied warranties of any kind, 
including warranties of merchantability, fitness for a particular 
purpose, or non-infringement of intellectual property. In connection 
with your use of this Manual, Artillery shall not be liable to you for 
any damages whatsoever, be they direct, economic, commercial, 
special, consequential, incidental, exemplary, or indirect damages, 
even if Artillery has been advised of the possibility of such damages, 
including without limitation, loss of business revenue or earnings, 
lost data, or lost profits. Artillery assumes no responsibility, nor 
will be liable, for any damages to, or any viruses or malware that 
may infect, your computer, telecommunication equipment, or 
other property caused by or arising from your downloading of 
any information or materials related to this Manual. The foregoing 
exclusions do not apply to the extent prohibited by law please refer 
to your local laws for any such prohibitions. 
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LETTER FROM ARTILLERY
Dear Customer, 

Thank you for choosing Artillery Sidewinder X2 3D Printer.

This guide will step you through the assembly and the first run of the 
printer. If you have any problems during assembly, please contact our 
customer service or visit our official Facebook group at:

https://www.facebook.com/groups/artilleryswx2/ 

For a detailed warranty policy, please visit 
https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty 

For support, please send an email to support@artillery3d.com 
or visit our ticketing page at 
https://desk.zoho.com/portal/evnovo/newticket 

Or you can visit our Facebook group at 
https://www.facebook.com/artillery3d

Regards,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Last update date: 6 August 2021
This manual is updated to the date of printing, 
please refer to the electronic version if in doubt.
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ENACCESSORY CHECKLIST
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STEP 2

STEP 1

ASSEMBLY

The M5 screws used to fasten the XZ gantry to the base are pre-inserted 
into the extrusion, use the Allen key provided to tighten the screws.

Push the aluminum extrusions against the inside of the slot when tight-
ening the screws.

Align the XZ gantry to the base, make sure the connector is perfectly 
aligned to the female connector on the base.
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STEP 3

Assemble the spool holder as shown in picture, then slide it into the 
slots on the top of the top beam. Then use the knob supplied to fix it in 
place.
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STEP 4

Connect the Z stepper motors and filament runout sensor.



- 11 -

EN
STEP 5

STEP 6

Loosen the 6 screws holding the carriages on both sides then tighten 
them ONLY when wheels on Z carriages not properly seating on the 
aluminum extrusions.

Adjust the bed carriage and hotend carriage by turning the eccentric 
nuts with the wrench supplied.
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LEVELING THE BUILD PLATE
The Sidewinder X2 comes with Auto Bed Leveling Sensor, it will 
perform a self-test when you power on the printer, if it doesn't, 
please do not proceed and check on the cables to make sure they're 
correctly seated.

1.	 Home the printer;
2.	 Heat up the bed and the hotend to 70 ° C and 240 ° C respectively;
3.	 Go to Tools -> Level;
4.	 Slide a piece of A4 paper between the nozzle and the build plate;
5.	 Move the hotend to all 4 corners to repeat step 6;
6.	 Turn the leveling knob under the bed closest to the nozzle until the 

piece of paper slides, with just a bit of drag;
7.	 From the menu, go to Tools -> More and click on Auto-Level;
8.	 The printer will initialize the auto bed leveling procedure, wait till it 

finishes;
9.	 Click EEPROM Save;
10.	Do the following only if the nozzle is  scratching on the build plate or 

the nozzle too far from the build plate;
11.	Heat up the bed and the hotend to 70 ° C and 240 ° C respectively;
12.	Go to Tools -> More -> Z=0;
13.	The nozzle will move to the center and at 0 height;
14.	Slide the A4 paper between the nozzle and bed again, use +0.025 

and -0.025 button to adjust the nozzle distance from the build plate 
until the piece of paper slides, with just a bit of drag;

15.	Click EEPROM Save once you’re happy with the drag on the A4 paper;
16.	Repeat Step 2 to Step 9.
17.	To enable compensation for auto-leveling, add M420 S1 Z10 after 

G28 in starting Gcode.
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ENPREPARING SLICING SOFTWARE
This printer works with most slicing software like Slic3r, Cura, 
Simplify3D, etc. But we will go into detail about Cura software and 
tell you how to set it up so that you can make your first print. First, 
please download the software from their official site.

After installation and start the software, you should see the 
following screen, continue until you see Add a printer page:
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In the Add a non-networked printer, scroll down to Artillery and 
choose Artillery Sidewinder X1, and type in Artillery Sidewinder X2 
in Printer name. Then click on Next button.

Set X (Width), Y (Depth) as 300, Z (Height) as 400. Make sure Heated 
Bed is checked.
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Change Compatible material diameter to 1.75

Drag and drop the STL file (or other supported format) to the slicer 
or load the model file with File -> Open File(s)...
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From the Profile dropdown, choose the preferred profile.

Click on Slice button.
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You can click on Save to Removable Drive (if the memory card is 
detected) or Save to file button to save the sliced file to the memory 
card.

Save the file to the memory card for printing.
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Insert the USB Drive / memory card into the printer then click on 
PRINT.

Choose the file you want to print.
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Click on Confirm and the print should start.
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SPECIFICATIONS
PRINTING

SIZE & WEIGHT

ELECTRICAL

MECHANICAL

Print Technology: Fused Deposition Modeling
Build Volume: 300x300x400 mm (11.8x11.8x15.7 in)
Layer Resolution: 100-300 microns
Filament: 1.75 mm (0.069 in)
Nozzle Diameter: 0.4 mm (0.015 in)
Print File Type: Gcode
Material Compatibility: PLA, PETG, TPU

Product Dimensions: 550x470x730 mm (21.7x18.5x28.7 in)
Shipping Box: 668x508x310 mm (26.3x20.0x12.2 in)
Printer Weight: 12.9 kg (28.4 lbs)
Shipping Weight: 16 kg (35.3lbs)

Power Requirements: 110V/220V, 350W
Connectivity: Memory Card, USB Stick, USB

Construction: Aluminum, ABS
Build Surface: Glass + Aluminum plate
Stepper Motors: 1.8° step angle with 1/256 micro-stepping
XY Positioning Precision: 10 microns
Z Positioning Precision: 100 microns
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ENCONTACT
Support desk.zoho.com/portal/evnovo/en/newticket

At Artillery, we take pride in offering expert, 
responsive, friendly customer support to 
customers around the world. If you need help 
resolving an issue with your Artillery 3D printer, 
visit the web address above to submit a ticket.

Sales ytcz@artillery3d.com
To learn about other Artillery products, please 
email the address above.

Feedback ytcz@artillery3d.com
For general questions, or to tell us what’s on 
your mind, send an email to the address above. 
We love to hear from you.
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LIES MICH ZUERST !
LESEN SIE DIESES HANDBUCH VOLLSTÄNDIG, BEVOR SIE 
IHREN DRUCKER ZUSAMMENBAUEN UND EINSCHALTEN!
GEFAHREN UND WARNUNGEN
Der Artillery Sidewinder X2 3D-Drucker verfügt über motorisierte 
und beheizte Teile. Beachten Sie immer mögliche Gefahren, wenn 
der Drucker in Betrieb ist.

STROMSCHLAGGEFAHR
Öffnen Sie niemals den Elektronikschacht des Druckers, während 
der Drucker eingeschaltet ist. Schalten Sie den Drucker immer aus 
und ziehen Sie das Netzkabel ab, bevor Sie die Zugangsklappe 
entfernen.

VERBRENNUNGSGEFAHR
Berühren Sie niemals die Extruderdüse, den Heizblock oder das 
beheizte Bett, ohen es vollständig abkühlen zu lassen. Es kann 
bis zu zwanzig Minuten dauern, bis Düse und das beheizte Bett 
vollständig abgekühlt sind. Berühren Sie auch niemals kürzlich 
extrudierte Filamente. Das Filament kann an Ihrer Haut haften und 
Verbrennungen verursachen.

BRANDGEFAHR
Lassen Sie niemals brennbare Materialien oder Flüssigkeiten auf oder 
in der Nähe des Druckers, wenn dieser eingeschaltet oder in Betrieb ist. 
Flüssiges Aceton und Dämpfe sind extrem entflammbar.

QUETSCHGEFAHR
Achten Sie beim Betrieb des Druckers darauf, dass Sie niemals Ihre Finger 
in die beweglichen Teile Stecken. Wie z.B: Riemen, RIemenscheiben, 
Zahnräder, Räder oder Gewindespindeln.

STATISCHE AUFLADUNG
Stellen Sie sicher, dass Sie sich geerdet haben, bevor Sie den Drucker 
berühren, insbesondere die Elektronik. Elektrostatische Aufladungen 
können elektronische Komponenten beschädigen. Berühren Sie eine 
geerdete Quelle, um sich selbst zu erden.

ALTERSWARNUNG
Für Benutzer unter 18 Jahren wird die Aufsicht durch Erwachsene 
empfohlen. Achten Sie auf Erstickungsgefahren bei Kindern.
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RECHTLICHES
PRODUKTGARANTIE

Für den Artillery Sidewinder X2 3D-Drucker gilt eine eingeschränkte 
Garantie. Allgemeine Geschäftsbedingungen finden Sie unter 
https://desk.zoho.com/portal/evnovo/en/kb/articles/evnovo-
limited-warranty

GESAMTBESTIMMUNGEN
Alle Informationen in dieser Bedienungsanleitung (“Handbuch”) 
können jederzeit ohne vorherige Ankündigung geändert werden 
und dienen nur der Übersichtlichkeit. Shenzhen Yuntuchuangzhi 
Technology Co., Ltd. und unsere jeweiligen verbundenen 
Unternehmen und Lieferanten (“Artillery”) behalten sich das 
Recht vor, dieses Handbuch nach eigenem Ermessen und jederzeit 
zu ändern oder zu überarbeiten, und verpflichten sich nicht, solche 
Änderungen, Aktualisierungen, Verbesserungen, oder andere 
Ergänzungen zu diesem Handbuch rechtzeitig oder überhaupt 
nicht. Sie stimmen zu, an Änderungen und / oder Überarbeitungen 
gebunden zu sein. Wenden Sie sich an das Artillery Support Team, 
um aktuelle Informationen zu erhalten.

GEISTIGES EIGENTUM
Das Design dieses Handbuchs sowie alle Texte, Grafiken, 
Informationen, Inhalte und sonstigen Materialien sind durch das 
Urheberrecht und andere Gesetze geschützt. Der Inhalt unterliegt 
dem Copyright 2021 Artillery. Alle Rechte vorbehalten. Bestimmte in 
diesem Handbuch verwendete Marken, Handelsnamen und Logos 
(die “Marken”) sind eingetragene und nicht eingetragene Marken, 
Handelsnamen von Artillery und seinen verbundenen Unternehmen. 
Nichts, was in diesem Handbuch enthalten ist, gewährt oder 
sollte so konstruiert werden, dass implizit, in irgendeiner Form 
oder auf andere Weise eine Lizenz oder ein Nutzungsrecht ohne 
die schriftliche Genehmigung von Artillery gewährt wird. Jede 
nicht autorisierte Verwendung von Informationen, Materialien 
oder Marken kann gegen Urheberrechtsgesetze, Markengesetze, 
Datenschutz- und Publizitätsgesetze und / oder andere Gesetze 
und Vorschriften verstoßen.
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HAFTUNGSAUSSCHLUSS
Artillery übernimmt keine Gewähr für die Richtigkeit oder 
Vollständigkeit der Informationen, Produkte oder Dienstleistungen, 
die durch oder durch dieses Handbuch bereitgestellt werden, und 
übernimmt keine Verantwortung für typografische, technische 
oder andere Ungenauigkeiten in diesem Handbuch, das “wie 
besehen” und ohne ausdrückliche Angaben bereitgestellt wird 
oder implizite Garantien jeglicher Art, einschließlich Garantien der 
Marktgängigkeit, der Eignung für einen bestimmten Zweck oder 
der Nichtverletzung von geistigem Eigentum. Im Zusammenhang 
mit Ihrer Verwendung dieses Handbuchs haftet Artillery Ihnen 
gegenüber nicht für Schäden jeglicher Art, sei es direkte, 
wirtschaftliche, kommerzielle, besondere, Folgeschäden, zufällige, 
beispielhafte oder indirekte Schäden, selbst wenn Artillery auf die 
Möglichkeit hingewiesen wurde von solchen Schäden, einschließlich, 
ohne Einschränkung, Verlust von Geschäftserlösen oder -erträgen, 
Datenverlust oder entgangenen Gewinn. Artillery übernimmt keine 
Verantwortung oder Haftung für Schäden oder Viren oder Malware, 
die Ihren Computer, Ihre Telekommunikationsgeräte oder andere 
Gegenstände infizieren können, die durch das Herunterladen 
von Informationen oder Materialien im Zusammenhang mit 
diesem Handbuch verursacht wurden oder daraus entstehen. 
Die vorstehenden Ausschlüsse gelten nicht in dem gesetzlich 
verbotenen Umfang. Informationen zu solchen Verboten finden Sie 
in Ihren örtlichen Gesetzen.
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BRIEF VON ARTILLERY
Sehr geehrter Kunde, 

Vielen Dank, dass Sie sich für den Artillery Sidewinder X2 3D-Drucker 
entschieden haben.

Diese Anleitung führt Sie durch die Baugruppe und den ersten 
Durchlauf des Druckers. Wenn Sie während der Montage Probleme 
haben, wenden Sie sich bitte an unseren Kundenservice oder besuchen 
Sie unsere offizielle Facebook-Gruppe unter:

https://www.facebook.com/groups/artilleryswx2/ 

Detaillierte Garantiebestimmungen finden Sie unter

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty 

Für Support senden Sie bitte eine E-Mail an support@artillery3d.com

oder besuchen Sie unsere Ticketseite unter

https://desk.zoho.com/portal/evnovo/newticket 

Oder besuchen Sie unsere Facebook-Gruppe unter 
https://www.facebook.com/artillery3d

Grüße,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Datum des letzten Updates: August 6, 2021
Dieses Handbuch wird auf das Druckdatum aktualisiert.
Im Zweifelsfall beziehen Sie sich bitte auf die elektronische Version.
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ZUBEHÖR-CHECKLISTE
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MONTAGE

SCHRITT 2

SCHRITT 1

Richten Sie das XZ-Portal an der Basis aus und stellen Sie sicher, dass 
der Stecker perfekt auf die Buchse an der Basis ausgerichtet ist.

Die M5-Schrauben zur Befestigung des XZ-Portals an der Basis sind 
bereits in das Profil eingesetzt, verwenden Sie den mitgelieferten In-
busschlüssel zum Anziehen der Schrauben.
Drücken Sie beim Anziehen der Schrauben die Aluminiumprofile gegen 
die Innenseite des Schlitzes.
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DESCHRITT 3

Montieren Sie den Spulenhalter wie in der Abbildung gezeigt und 
schieben Sie ihn dann in die Schlitze oben am oberen Träger. Befestigen 
Sie es dann mit dem mitgelieferten Knopf.
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SCHRITT 4

Schließen Sie die Z-Schrittmotoren und den Rundlaufsensor an.
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SCHRITT 5

SCHRITT 6

Stellen Sie den Bettwagen und den Hotend-Wagen ein, indem Sie die 
Exzentermuttern mit dem mitgelieferten Schraubenschlüssel drehen.

Lösen Sie die 6 Schrauben, die die Wagen auf beiden Seiten halten, und 
ziehen Sie sie NUR fest, wenn die Räder der Z-Schlitten nicht richtig auf 
den Aluminiumprofilen sitzen.
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DRUCKPLATTE AUSRICHTEN (LEVELN)
Der Sidewinder X2 wird mit einem automatischen 
Bettnivellierungssensor geliefert. Er führt einen Selbsttest durch, 
wenn Sie den Drucker einschalten. Wenn dies nicht der Fall ist, fahren 
Sie bitte nicht fort und überprüfen Sie die Kabel, um sicherzustellen, 
dass sie richtig sitzen.

1.	 Den Drucker nach Hause bringen.
2.	 Heizen Sie das Bett und das Hotend auf 70 ° C bzw. 240 ° C auf.
3.	 Gehen Sie zu Tools -> Level.
4.	 Schieben Sie ein Stück A4-Papier zwischen die Düse und die 

Bauplatte.
5.	 Bewegen Sie das Hotend in alle 4 Ecken, um Schritt 6 zu wiederholen.
6.	 Drehen Sie den Nivellierknopf unter dem Bett, das der Düse am 

nächsten liegt, bis das Stück Papier mit nur wenig Widerstand gleitet.
7.	 Gehen Sie im Menü zu Tools -> More und klicken Sie auf Auto-Level.
8.	 Der Drucker initialisiert den automatischen Bettnivellierungsvorgang 

und wartet, bis er abgeschlossen ist.
9.	 Klicken Sie auf EEPROM Save.
10.	Führen Sie die folgenden Schritte nur aus, wenn die Düse auf der 

Bauplatte kratzt oder die Düse zu weit von der Bauplatte entfernt ist.
11.	Heizen Sie das Bett und das Hotend auf 70 ° C bzw. 240 ° C auf;
12.	Gehen Sie zu Tools -> More -> Z = 0;
13.	Die Düse bewegt sich in die Mitte und in Höhe von 0;
14.	Schieben Sie das A4-Papier erneut zwischen Düse und Bett. Stellen 

Sie mit den Tasten +0.025 und -0.025 den Düsenabstand von der 
Bauplatte ein, bis das Blatt Papier mit nur geringem Widerstand 
gleitet.

15.	Klicken Sie auf EEPROM Save, wenn Sie mit dem Ziehen des A4-
Papiers zufrieden sind.

16.	Wiederholen Sie die Schritte 2 bis 9.
17.	Um die Kompensation für die automatische Nivellierung zu 

aktivieren, fügen Sie M420 S1 Z10 nach G28 im Start-Gcode hinzu.
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SLICING-SOFTWARE VORBEREITEN
Dieser Drucker funktioniert mit den meisten Slicing-Programmen 
wie Slic3r, Cura, Simplify3D usw. Wir werden jedoch detailliert 
auf die Cura-Software eingehen und Ihnen erklären, wie Sie sie 
einrichten, damit Sie Ihren ersten Druck erstellen können. Laden Sie 
zunächst die Software von der offiziellen Website herunter.

Nach der Installation und dem Starten der Software sollte der 
folgende Bildschirm angezeigt werden. Fahren Sie fort, bis die Seite 
Druckerseite angezeigt wird:
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Scrollen Sie unter Einen unvernetzten Drucker hinzufügen, nach 
unten zu Custom und wählen Sie Custom FFF Printer. Geben Sie 
Artillery Sidewinder X2 in Druckername ein. Klicken Sie dann auf 
die Schaltfläche Hinzufügen.

Stellen Sie X (Breite), Y (Tiefe) auf 300, Z (Höhe) auf 400 ein. Stellen 
Sie sicher, dass Heizbares Bett aktiviert ist.
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Ändern Sie Kompatibler Materialdurchmesser auf 1,75

Ziehen Sie die STL-Datei (oder andere unterstützte Formate) per 
Drag & Drop in den Slicer oder laden Sie die Modelldatei mit Datei 
-> Dateien öffnen... 
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Wählen Sie in der Dropdown-Liste Profil das bevorzugte Profil aus.

Klicken Sie auf die Schaltfläche Slice.
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Sie können auf Speichern auf Wechseldatenträger (wenn die 
Speicherkarte erkannt wird) oder auf In Datei speichern klicken, um 
die geschnittene Datei auf der Speicherkarte zu speichern.

Speichern Sie die Datei zum Drucken auf der Speicherkarte.
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Stecken Sie das USB-Laufwerk / die Speicherkarte in den Drucker 
und klicken Sie auf PRINT.

Wählen Sie die Datei aus, die Sie drucken möchten.
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Klicken Sie auf Confirm und der Druck sollte beginnen.
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SPEZIFIKATIONEN
DRUCKEN

GRÖSSE GEWICHT

ELEKTRISCH

MECHANISCH

Drucktechnologie: Fused Deposition Modeling
Build Volume: 300x300x400 mm (11,8x11,8 x15,7 Zoll)
Ebenenauflösung: 100-300 Mikrometer
Filament  Durchmesser: 1,75 mm (0,069 in)
Düsendurchmessern: 0,4 mm (0,015 in)
Dateityp drucken: Gcode
Materialverträglichkeit: PLA, PETG, TPU

Produktabmessungen: 550x470x730 mm (21,7x18,5x28,7 Zoll)
Versandkarton: 668x508x310 mm (26,3x20,0x12,2 Zoll)
Druckergewicht: 12,9 kg (28,4 lbs)
Liefergewicht: 16 kg (35.3lbs)

Leistungsbedarf: 110V/220V, 350W
Konnektivität: Speicherkarte, USB-Laufwerk, USB

Konstruktion: Aluminium, ABS
Oberfläche bauen: Glas + Aluminiumplatte
Schrittmotoren: 1,8 ° Schrittwinkel mit 1/256 Mikroschritt
XY Positioniergenauigkeit: 10 Mikrometer
Z Positioniergenauigkeit: 100 Mikrometer



DE

- 41 -

KONTAKT
Unterstützung desk.zoho.com/portal/evnovo/en/newticket

Wir bei Artillery sind stolz darauf, Kunden auf der 
ganzen Welt kompetenten, reaktionsschnellen 
und freundlichen Kundensupport zu bieten. 
Wenn Sie Hilfe bei der Lösung eines Problems 
mit Ihrem Artillery 3D-Drucker benötigen, 
besuchen Sie die oben angegebene 
Webadresse, um ein Ticket einzureichen.

Umsatz ytcz@artillery3d.com
Um mehr über die Produkte anderer Artillery 
zu erfahren, senden Sie bitte eine E-Mail an die 
oben angegebene Adresse.

Feedback ytcz@artillery3d.com
Wenn Sie allgemeine Fragen haben oder uns 
mitteilen möchten, was Sie denken, senden Sie 
eine E-Mail an die oben angegebene Adresse. 
Wir freuen uns von Ihnen zu hören.
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请先读我

安装及使用本机前，请先详阅本手册！

危险和警告
此Artillery响尾蛇 X2 3D打印机含有电机及加热部件。打印机运作
时，请始终注意可能存在的危险。

触电危险
打印机电源打开时，切勿打开打印机的机箱。在打开机箱检修前，
请务必关闭打印机电源并拔下电源线。

灼伤危险
在喷嘴、加热块、热床还没完全冷却前，千万不要直接触摸。此些
部件可能需要20分钟以上才能完全冷却。同时，不要触摸刚挤出的
耗材，未冷却的塑料有可能粘住皮肤导致灼伤。

失火危险
在打印机运行时，切勿在打印机上或附近放置易燃材料或液体。液体丙酮及
挥发气体极易燃烧。

夹伤危险
在打印机运行时，请小心不要将手指放在活动部件上，包括皮带，皮带轮，
齿轮，滚轮或螺杆。

静电
在接触打印机之前，请务必将自己接地，尤其是电子设备。静电可能会损
坏电子元件。要自己接地，请触摸接地源。

年龄警告
对于18岁以下的用户，建议成人进行监督。小心小零件对儿童有窒息危
险。
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法律声明
保修

本公司为Artillery响尾蛇 X2 3D打印机提供一年保修，具体内容及
细则，请参阅https://desk.zoho.com/portal/evnovo/en/kb/
articles/evnovo-limited-warranty

总体规定

知识产权

本用户手册（“手册”）中的所有信息随时可能更改，恕不另行通
知，仅出于方便目的而提供。深圳市云图创智科技有限公司及其各
自的关联公司和供应商（以下简称“Artillery”）保留随时自行决
定修改或修订本手册的权利，并且不承诺提供任何此类更改、更
新、增强或及时或根本没有对本手册进行其他补充。您同意接受任
何修改和/或修订的约束。请访问www.artillery3d.cn官方网站以
获取最新的产品信息。

本手册的设计以及所有文本，图形，信息，内容和其他材料均受版
权法和其他法律保护。内容版权归Artillery所有。本手册中使用的
某些商标，商号和徽标（“商标”）是Artillery及其附属公司的注
册和未注册商标、商号。未经Artillery书面许可，本手册中的任何
内容均不得以暗示，禁止反言或其他方式授予或构成为授予任何许
可或使用权。 未经授权使用任何信息、材料或标记可能会违反版权
法、商标法、隐私和宣传法和/或其他法律法规。
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免责声明
Artillery不保证本手册提供或通过本手册提供的信息、产品或服务
的准确性或完整性，并对本手册中的任何印刷、技术或其他不正确
之处不承担任何责任。或任何形式的默示担保，包括适销性、针对
特定目的的适用性担保或不侵犯知识产权的担保。就您使用本手册
而言，即使Artillery已被告知可能造成的任何直接或间接的、经济
的、商业的、特殊的、后果性的、附带的、示例性的或间接的损
坏，Artillery也不对您承担任何责任。此类损害包括但不限于营业
收入或收入损失、数据损失或利润损失。对于因您下载与本手册相
关的任何信息或材料而引起或对您的计算机、电信设备或其他财产
造成的任何损害或任何病毒或恶意软件的感染，Artillery不承担任
何责任。上述排除条款不适用于法律禁止的范围，请参阅您当地的
法律。

一旦使用本产品，即视为您已经仔细阅读免责声明与警告，理解、
认可和接受本声明全部条款和内容。您承诺对使用本产品及可能带
来的后果负全部责任。您承诺仅出于正当目的使用本产品，并且同
意本条款以及Artillery指定的任何相关条例、政策和指引。
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来自ARTILLERY的信
亲爱的顾客，

感谢您选择Artillery响尾蛇 X2 3D打印机。

本手册将一步一步带领您从组装到第一次使用此打印机进行打印。如果
您在组装的时候遇到了什么问题，请跟我们的售后团队联系，请电邮至 
support@artillery3d.com 或到我们的官方 Facebook 专页：

https://www.facebook.com/groups/artilleryswx2/ 

详细的保修政策，请参阅： 
https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty （英文） 
 
同时，您亦可到我们的售后系统提交售后要求 
https://desk.zoho.com/portal/evnovo/newticket 
 
我司Facebook专页： 
https://www.facebook.com/artillery3d

深圳市云图创智科技有限公司
最后更新日期：2021年8月6日
本手册内容更新截止至印刷当日，
如有更新改动，请参考最新的电子版本。
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配件清单
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第二步

第一步

组装

将XZ龙门架对准底座上的槽，确保排线针脚准确对准插槽。

使用预埋在型材上的4颗M5螺丝把XZ龙门架锁紧在底座上，在锁紧
螺丝时，确定把型材靠紧内侧再锁紧，以防出现外八字。
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第三步

按下图显示组装料架，然后安装到顶部横梁上，并用所附之螺丝把
料架锁紧。
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第四步

连接Z轴电机及断料器。
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第五步

第六步

使用六角扳手调整热床及喷嘴滑块的偏心轮松紧。

在其中一边的轮子没有紧压在铝型材的情况下，松开固定两侧Z马车的6个
螺丝，然后重新拧紧。
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调平打印平台
响尾蛇 X2 附设自动调平功能，自动调平装置在开机的时候会进行
自我测试，如果该装置并没有进行自我检测，请勿进行下一步并检
查所有接线。

1.	 复位打印机；
2.	 把热床及加热头分别加热至70 ° C 及 240 ° C；
3.	 在触屏点解 工具 -> 调平；
4.	 在加热头和热床之间放置一张A4纸；
5.	 通过触屏把加热头移动至4个角落并重复第6步；
6.	 扭动调平旋钮而调整热床与加热头间之距离，达至A4纸能在之间滑动同

时能感到有一点压力；
7.	 在触屏点击 工具 -> 更多，然后点击 自动调平；
8.	 等待自动调平程序结束；
9.	 单击 EEPROM保存；
10.	 仅当喷嘴刮擦底板或喷嘴距离底板太远时，才执行以下操作；
11.	 将热床和加热头分别加热到70°C和240°C;
12.	 转到 工具 -> 更多 ->  Z = 0；
13.	 加热头将移至中心并移至0高度。
14.	 再次在加热头和底座之间滑动A4纸，使用 +0.025 和 -0.025  按钮

调整加热头与底板的距离，直到A4纸能在之间滑动同时能感到有一点压
力；

15.	 对A4纸上的压力满意后，单击 EEPROM保存；
16.	 重复 第2步到 第9步；
17.	 在切片软件的开始 Gcode 中，在 G28 之后添加 M420 S1 Z10 以启

动自动调平补偿。
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切片软件准备
本打印机可与大多数切片软件一起使用，例如 Slic3r， Cura， 
Simplify3D 等。但是我们将详细介绍Cura软件，并告诉您如何进
行设置，以便进行首次打印。 首先，请从其官方网站下载。

安装并启动软件后，您应该看到以下屏幕，继续直到看到“添加打
印机”页面：
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在 添加未联网打印机 中，向下滚动到 Artillery，然后选择 Artillery 
Sidewinder X1，然后在 打印机名称 中键入 Artillery 响尾蛇 X2。 然后
单击 添加 按钮。

将 X（宽度），Y（深度）设置为 300，将 Z（高度）设置为 400。确保
选中加热床。
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将 兼容的材料直径 更改为 1.75。

将 STL 文件（或其他受支持的格式）拖放到切片软件，或使用 文件 -> 打
开文件（O）... 
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从 配置文件 下拉列表中，选择想使用的配置。

单击 切片 按钮。
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您可以单击 保存至可移动磁盘 （如果检测到存储卡）或 保存到文件 按钮
以将切片的文件保存到存储卡。

将文件保存到存储卡以进行打印。
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插入U盘或记忆卡，然后点击 打印。

选择您要打印的文件。



CN

- 59 -

点击 确定 以开始打印。
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规格
打印相关

尺寸及重量

电气

机械

打印技术： 熔融沉积建模
打印体积： 300x300x400 毫米 (11.8x11.8x15.7 英寸)
层分辨率： 100-300 微米
耗材直径： 1.75 毫米 (0.069 英寸)
喷嘴直径： 0.4 毫米 (0.015 英寸)
打印文件格式： Gcode
兼容耗材： PLA, PETG, TPU

产品尺寸： 550x470x730 毫米 (21.7x18.5x28.7 英寸)
包装尺寸： 668x508x310 毫米 (26.3x20.0x12.2 英寸)
机器重量： 12.9 公斤 (28.4 磅)
装运重量： 16 公斤 (35.3 磅)

电源要求： 110V/220V, 350W
连接性： 记忆卡, U盘，USB

结构构造： 铝，ABS
打印平台： 钢化玻璃 + 铝板
步进电机： 1.8° 步角距 1/256 细分
XY 定位精度： 10 微米
Z 定位精度： 100 微米
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联系方式
售后支持 desk.zoho.com/portal/evnovo/en/newticket

在Artillery，我们为向全球客户提供专业，响应迅
速，友好的客户支持而感到自豪。如果您需要解
决您的Artillery 3D打印机问题的帮助，请访问上
面的网址提交票证。

销售 ytcz@artillery3d.com
要了解其他Artillery产品，请通过电子邮件发送以
上地址。

反馈 ytcz@artillery3d.com
如有一般性问题，或者想告诉我们您的想法，请
发送电子邮件至上述地址。 我们很高兴收到您的
来信。
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ES

LÉEME PRIMERO
LEA ESTE MANUAL POR COMPLETO ANTES DE 
ENSAMBLAR Y ENCENDER SU IMPRESORA.
PELIGROS Y ADVERTENCIAS
La impresora Artillery Sidewinder X2 3D tiene piezas motorizadas 
y calentadas. Cuando la impresora esté en funcionamiento, esté 
siempre atento a los posibles peligros.

PELIGRO DE DESCARGA ELÉCTRICA
Nunca abra el compartimiento de la electrónica de la impresora 
mientras la impresora está encendida. Antes de retirar el panel 
de acceso, siempre apague la impresora y desenchufe el cable de 
alimentación de corriente.

PELIGRO DE QUEMADURAS
Nunca toque la boquilla del extrusor, el bloque calefactor o la cama 
caliente sin antes apagar el hotend y la cama caliente y dejar que 
se enfríe por completo. El hotend y la cama caliente pueden tardar 
hasta veinte minutos en enfriarse por completo. Además, nunca 
toque los filamentos recién extruidos. El filamento puede adherirse 
a su piel y causarle quemaduras.

PELIGRO DE INCENDIO
Nunca deje materiales o líquidos inflamables encima o cerca de la 
impresora cuando esté encendida o en funcionamiento. La acetona 
líquida y sus vapores son extremadamente inflamables.

PELIGRO DE ATRAPAMIENTO
Cuando la impresora esté en funcionamiento, tenga cuidado de no 
meter los dedos en las piezas móviles, incluidas las correas, poleas, 
engranajes, ruedas o tornillos de avance.

CARGA ESTÁTICA
Asegúrese de conectarse a tierra antes de tocar la impresora, 
especialmente los componentes electrónicos. Las cargas electrostáticas 
pueden dañar los componentes electrónicos. Para conectarse a tierra, 
toque una fuente conectada a tierra.

ADVERTENCIA DE EDAD
Para usuarios menores de 18 años, se recomienda la supervisión de un 
adulto. Tenga cuidado con los peligros de asfixia en niños.
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LEGALIDAD
LA GARANTÍA DEL PRODUCTO

La impresora 3D Artillery Sidewinder X2 está cubierta por una 
garantía limitada. Para conocer los términos y condiciones, consulte 
https://desk.zoho.com/portal/evnovo/en/kb/articles/evnovo-
limited-warranty

DISPOSICIONES GENERALES
Toda la información contenida en este manual de usuario 
(“Manual”) está sujeta a cambios en cualquier momento sin previo 
aviso y se proporciona únicamente con fines prácticos. Shenzhen 
Yuntuchuangzhi Technology Co., Ltd. y nuestras respectivas filiales 
y proveedores (“Artillería”) se reservan el derecho modificar o 
revisar este manual a su entera discreción y en cualquier momento 
y no se compromete a proporcionar tales cambios, actualizaciones, 
mejoras u otras adiciones a este manual de manera oportuna o en 
absoluto. Usted acepta estar sujeto a cualquier modificación y / o 
revisiones Comuníquese con el Equipo de Apoyo de Artillery para 
obtener información actualizada.

PROPIEDAD INTELECTUAL
El diseño de este manual y todo el texto, gráficos, 
información, contenido y otros materiales están protegidos 
por derechos de autor y otras leyes. Los contenidos son 
copyright 2021 Artillery. Todos los derechos reservados. 
Ciertas marcas comerciales, nombres comerciales y 
logotipos (las “Marcas”) que se utilizan en este manual son 
marcas comerciales registradas y no registradas, nombres 
comerciales de Artillery y sus filiales. Nada de lo contenido 
en este Manual otorga o debe interpretarse como una 
concesión, por implicación, impedimento legal o de otro 
modo, cualquier licencia o derecho de uso sin el permiso por 
escrito de Artillery. Cualquier uso no autorizado de cualquier 
información, materiales o Marcas puede violar las leyes de 
derechos de autor, las leyes de marcas registradas, las leyes 
de privacidad y publicidad y / u otras leyes y regulaciones.
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ES

AVISO LEGAL
Artillery no garantiza la exactitud o integridad de la información, 
los productos o los servicios proporcionados por este Manual oa 
través de este y no asume ninguna responsabilidad por cualquier 
inexactitud tipográfica, técnica o de otro tipo en este Manual, que se 
proporciona “tal cual” y sin ningún tipo de o garantías implícitas 
de cualquier tipo, incluidas las garantías de comerciabilidad, 
idoneidad para un propósito particular o no infracción de la 
propiedad intelectual. En relación con el uso de este Manual, 
Artillery no será responsable ante usted por ningún daño, ya sea 
directo, económico, comercial, especial, consecuente, incidental, 
ejemplar o indirecto, incluso si Artillery ha sido advertido de la 
posibilidad. de dichos daños, incluidos, entre otros, la pérdida de 
ingresos o ganancias comerciales, la pérdida de datos o la pérdida 
de beneficios. Artillery no asume ninguna responsabilidad, ni será 
responsable, por ningún daño o virus o malware que pueda infectar 
su computadora, equipo de telecomunicaciones u otra propiedad 
causada por o que surja de la descarga de cualquier información 
o material relacionado con este manual. Las exclusiones anteriores 
no se aplican en la medida en que lo prohíba la ley. Consulte las 
leyes locales para conocer dichas prohibiciones.
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CARTA DE ARTILLERY
Estimado cliente, 

Gracias por elegir la impresora 3D Artillery Sidewinder X2.

Esta guía le orientará en el ensamblaje y la primera puesta en marcha 
de la impresora. Si tiene algún problema durante el montaje, póngase 
en contacto con nuestro servicio de atención al cliente o visite nuestro 
grupo oficial de Facebook en:

https://www.facebook.com/groups/artilleryswx2/ 

Para obtener una política de garantía detallada, visite

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty 

Para soporte, envíe un correo electrónico a support@artillery3d.com 
o visite nuestra página de venta de entradas en

https://desk.zoho.com/portal/evnovo/newticket 

O puede visitar nuestro grupo de Facebook en

https://www.facebook.com/artillery3d

Saludos,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Última Fecha de Actualización: agosto 6, 2021
Este manual está actualizado a la fecha de impresión,
consulte la versión electrónica en caso de duda.
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LISTA DE VERIFICACIÓN DE ACCESORIOS
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PASO 2

PASO 1

MONTAJE DE LA IMPRESORA

Alinee el pórtico XZ con la base, asegúrese de que el conector esté 
perfectamente alineado con el conector hembra de la base.

Los tornillos M5 que se utilizan para sujetar el pórtico XZ a la base están 
insertados previamente en la extrusión; utilice la llave Allen proporcio-
nada para apretar los tornillos.
Empuje las extrusiones de aluminio contra el interior de la ranura cuan-
do apriete los tornillos.
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PASO 3

Ensamble el portacarretes como se muestra en la imagen, luego 
deslícelo en las ranuras en la parte superior de la viga superior. Luego 
use la perilla suministrada para fijarlo en su lugar.
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PASO 4

Conecte los motores paso a paso Z y el sensor de agotamiento del 
filamento.
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PASO 5

PASO 6

Ajuste el carro de la cama y el carro del hotend girando las tuercas 
excéntricas con la llave suministrada.

Afloje los 6 tornillos que sujetan los carros en ambos lados y luego 
apriételos SOLAMENTE cuando las ruedas de los carros Z no se asienten 
correctamente en las extrusiones de aluminio.
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NIVELACIÓN DE LA PLACA DE CONSTRUCCIÓN
El Sidewinder X2 viene con un sensor de nivelación automática de 
la cama, realizará una autoprueba cuando encienda la impresora; 
si no lo hace, no proceda y compruebe los cables para asegurarse 
de que estén colocados correctamente.

1.	 Inicio de la impresora;
2.	 Calentar la cama y el hotend a 70 ° C y 240 ° C respectivamente;
3.	 Vaya a Tools -> Level;
4.	 Deslice un trozo de papel A4 entre la boquilla y la placa de impresión;
5.	 Mueva el hotend a las 4 esquinas para repetir el Paso 6;
6.	 Gire la perilla de nivelación debajo de la cama más cercana a la 

boquilla hasta que la hoja de papel se deslice, con solo un poco de 
arrastre;

7.	 Desde el menú, vaya a Tools -> More y haga clic en Auto-Level;
8.	 La impresora inicializará el procedimiento de nivelación automática 

de la cama, espere hasta que finalice;
9.	 Haga clic en EEPROM Save;
10.	Haga lo siguiente solo si la boquilla está rayando en la placa de 

construcción o si la boquilla está demasiado lejos de la placa de 
construcción;

11.	Calentar la cama y el hotend a 70 ° C y 240 ° C respectivamente;
12.	Vaya a Tools -> More -> Z = 0;
13.	La boquilla se moverá hacia el centro y a 0 altura;
14.	Deslice el papel A4 entre la boquilla y la cama nuevamente, use 

los botones +0.025 y -0.025 para ajustar la distancia de la boquilla 
desde la placa de construcción hasta que la hoja de papel se deslice, 
con solo un poco de arrastre;

15.	Haga clic en EEPROM Save una vez que esté satisfecho con el 
arrastre en el papel A4;

16.	Repita del Paso 2 al Paso 9.
17.	Para habilitar la compensación para la nivelación automática, 

agregue M420 S1 Z10 después de G28 en el Gcode inicial.
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PREPARACIÓN DE SOFTWARE DE CORTE
Esta impresora funciona con la mayoría de software de corte 
como Slic3r, Cura, Simplify3D, etc. Pero presentaremos en detalle 
el software Cura y le diremos cómo configurarlo para que pueda 
realizar su primera impresión. Primero, descargue el software de 
su sitio oficial.

Después de la instalación e inicio del software, debería ver la 
siguiente pantalla, continúe hasta que vea la página Agregar una 
impresora:
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En Agregar una impresora no conectada a la red, desplácese hacia 
abajo hasta Personalizado y elija Custom FFF Printer, y escriba 
Artillery Sidewinder X2 en Nombre de la impresora. Luego haga 
clic en el botón Next.

Establezca X (anchura), Y (profundidad) como 300, Z (altura) como 
400. Asegúrese de que la opción cama caliente (heated bed) esté 
marcada.
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Cambie el Diámetro del material compatible a 1,75

Arrastre y suelte el archivo STL (u otro formato compatible) en la 
cortadora o cargue el archivo del modelo con Archivo -> Abrir 
archivo (s) ...
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En el menú desplegable Perfil, elija el perfil preferido.

Haga clic en el botón Segmentación.
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Puede hacer clic en Guardar en unidad extraíble (si se detecta la 
tarjeta de memoria) o en el botón Guardar en archivo para guardar 
el archivo cortado en la tarjeta de memoria.

Guarde el archivo en la tarjeta de memoria para imprimir.
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Inserte la unidad USB / tarjeta de memoria en la impresora y 
luego haga clic en PRINT.

Elija el archivo que desea imprimir.
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Haga clic en Confirm y la impresión debería comenzar.
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ESPECIFICACIONES
PRINTING
Tecnología de impresión: Modelado por deposición fundida

Volumen de construcción: 300x300x400 mm 
(11,8x11,8x15,7 pulgadas)

Resolución de capa: 100-300 micrones
Diámetro del filamento: 1,75 mm (0,069 pulgadas)
Diámetro de la boquilla: 0,4 mm (0,015 pulgadas)
Tipo de archivo de impresión: Gcode
Compatibilidad material: PLA, PETG, TPU

TAMAÑO Y PESO

Dimensiones del producto: 550x470x730 mm 
(21,7x18,5x28,7 pulgadas)

Caja de envío: 668x508x310 mm 
(26,3x20,0x12,2 pulgadas)

Peso de la impresora: 12,9 kg (28,4 libras)
Peso de envío: 16 kg (35,3 libras)

ELÉCTRICA
Requerimientos de energía: 110V/220V, 350W
Conectividad: Tarjeta SD, Unidad USB, USB

MECÁNICA
Construcción: Aluminio, ABS
Superficie de construcción: Placa de vidrio + aluminio

Motores paso a paso: Ángulo de paso de 1,8 ° con 
micropasos de 1/256

XY Precisión de posicionamiento: 10 micrones
Z Precisión de posicionamiento: 100 micrones
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CONTACTO
Apoyo desk.zoho.com/portal/evnovo/en/newticket

En Artillery, nos enorgullecemos de ofrecer 
una atención al cliente experta, receptiva 
y accesible a clientes de todo el mundo. Si 
necesita ayuda para resolver un problema con 
su impresora Artillery 3D, visite la dirección 
web anterior para crear un ticket.

Ventas ytcz@artillery3d.com
Para obtener información sobre otros productos 
de Artillery, envíe un correo electrónico a la 
dirección anterior.

Retroalimentación ytcz@artillery3d.com
Para preguntas generales, o para trasladarnos 
lo que le preocupa, envíe un correo electrónico 
a la dirección anterior. Nos encanta saber de 
usted.
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ALERTE DE SÉCURITÉ
LISEZ COMPLÈTEMENT CE MANUEL AVANT D’ASSEMBLER 
ET DE MISE SOUS TENSION VOTRE IMPRIMANTE!
DANGERS ET AVERTISSEMENTS
L'imprimante 3D Artillery Sidewinder X2 possède des pièces 
motorisées et chauffées. Lorsque l'imprimante est en 
fonctionnement, soyez toujours conscient des dangers possibles.

RISQUE D’ÉLECTROCUTION
N'ouvrez jamais la baie électronique de l'imprimante lorsque 
l'imprimante est sous tension. Avant de retirer le panneau d'accès, 
mettez toujours l'imprimante hors tension et débranchez le cordon 
d'alimentation secteur.

RISQUE DE BRÛLURE
Ne touchez jamais la buse de l'extrudeuse, le bloc chauffant ou le 
lit chauffant sans d'abord éteindre le hotend et le lit chauffant et les 
laisser refroidir complètement. Le hotend et le lit chauffant peuvent 
prendre jusqu'à vingt minutes pour se refroidir complètement. De 
plus, ne touchez jamais aux filaments récemment extrudés. Le 
filament peut coller à votre peau et provoquer des brûlures.

RISQUE D’INCENDIE
Ne laissez jamais de matériaux ou de liquides inflammables sur 
ou à proximité de l’imprimante lorsqu’elle est sous tension ou en 
fonctionnement. L’acétone liquide et les vapeurs sont extrêmement 
inflammables.

RISQUE DE PINCEMENT
Lorsque l’imprimante fonctionne, veillez à ne jamais mettre vos doigts 
dans les pièces mobiles, y compris les courroies, poulies, engrenages, 
roues ou vis-mères.

CHARGE STATIQUE
Assurez-vous de vous mettre à la terre avant de toucher l’imprimante, 
en particulier l’électronique. Les charges électrostatiques peuvent 
endommager les composants électroniques. Pour vous mettre à la 
terre, touchez une source mise à la terre.

AVERTISSEMENT D’ÂGE
Pour les utilisateurs de moins de 18 ans, la surveillance d’un adulte 
est recommandée. Méfiez-vous des risques d’étouffement autour des 
enfants.
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LÉGALE
GARANTIE DU PRODUIT

L’imprimante 3D Artillery Sidewinder X2 est couverte par une 
garantie limitée. Pour les termes et conditions, voir https://desk.
zoho.com/portal/evnovo/en/kb/articles/evnovo-limited-warranty

DISPOSITIONS GÉNÉRALES
Toutes les informations contenues dans ce manuel d’utilisation 
(«Manuel») sont susceptibles d’être modifiées à tout moment sans 
préavis et sont fournies à des fins de commodité uniquement. 
Shenzhen Yuntuchuangzhi Technology Co., Ltd. et nos affiliés et 
fournisseurs respectifs («Artillery») se réservent le droit de modifier 
ou de réviser ce manuel à sa seule discrétion et à tout moment 
et ne prend aucun engagement de fournir de tels changements, 
mises à jour, améliorations, ou d’autres ajouts à ce manuel en 
temps opportun ou pas du tout. Vous acceptez d’être lié par toute 
modification et / ou révision. Contactez l’équipe de soutien de 
l’Artillery pour obtenir des informations à jour.

PROPRIÉTÉ INTELLECTUELLE
La conception de ce manuel et tous les textes, graphiques, 
informations, contenus et autres éléments sont protégés par le droit 
d’auteur et d’autres lois. Le contenu est protégé par copyright 2021 
Artillery. Tous les droits sont réservés. Certaines marques, noms 
commerciaux et logos (les «Marques») utilisés dans ce manuel sont 
des marques déposées et non déposées, des noms commerciaux 
d’Artillery et de ses filiales. Rien de ce qui est contenu dans ce 
manuel n’accorde ou ne doit être interprété comme accordant, 
par implication, préclusion ou autrement, une licence ou un droit 
d’utilisation sans l’autorisation écrite de Artillery. Toute utilisation 
non autorisée de toute information, matériel ou marque peut 
enfreindre les lois sur les droits d’auteur, les lois sur les marques, 
les lois sur la confidentialité et la publicité, et / ou d’autres lois et 
réglementations.
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AVERTISSEMENT
L’Artillery ne garantit pas l’exactitude ou l’exhaustivité des 
informations, produits ou services fournis par ou via ce manuel 
et n’assume aucune responsabilité pour toute inexactitude 
typographique, technique ou autre dans ce manuel, qui est 
fourni «tel quel» et sans aucune ou des garanties implicites de 
toute nature, y compris des garanties de qualité marchande, 
d’adéquation à un usage particulier ou de non-violation de la 
propriété intellectuelle. Dans le cadre de votre utilisation de 
ce manuel, l’Artillery ne sera pas responsable envers vous de 
quelque dommage que ce soit, qu’il s’agisse de dommages directs, 
économiques, commerciaux, spéciaux, consécutifs, accidentels, 
exemplaires ou indirects, même si l’Artillery a été informée de la 
possibilité. de tels dommages, y compris, sans s’y limiter, la perte 
de revenus ou de revenus commerciaux, la perte de données ou 
la perte de profits. Artillery n’assume aucune responsabilité et 
ne sera pas tenue responsable des dommages ou des virus ou 
logiciels malveillants susceptibles d’infecter votre ordinateur, votre 
équipement de télécommunication ou toute autre propriété causés 
par ou résultant de votre téléchargement de toute information ou 
matériel lié à ce manuel. Les exclusions ci-dessus ne s’appliquent 
pas dans la mesure interdite par la loi, veuillez vous référer à vos 
lois locales pour de telles interdictions.
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LETTRE DE ARTILLERY
Cher client,

Merci d’avoir choisi l’imprimante 3D Artillery Sidewinder X2.

Ce guide vous guidera à travers l'assemblage et la première exécution 
de l'imprimante. Si vous rencontrez des problèmes lors de l'assemblage, 
veuillez contacter notre service client ou visitez notre groupe Facebook 
officiel à l'adresse: 

https://www.facebook.com/groups/artilleryswx2/

Pour une politique de garantie détaillée, veuillez visiter

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty

Pour obtenir de l'aide, veuillez envoyer un e-mail à  
support@artillery3d.com

ou visitez notre page de billetterie à

https://desk.zoho.com/portal/evnovo/newticket 

Ou vous pouvez visiter notre groupe Facebook à

https://www.facebook.com/artillery3d

Cordialement,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Dernière date de mise à jour: 6 août 2021
Ce manuel est mis à jour à la date d'impression,
veuillez vous référer à la version électronique en cas de doute.
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LISTE DE VÉRIFICATION DES ACCESSOIRES
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ÉTAPE 2

ÉTAPE 1

ASSEMBLAGE DE L’IMPRIMANTE

Alignez le portique XZ sur la base, assurez-vous que le connecteur est 
parfaitement aligné avec le connecteur femelle de la base.

Les vis M5 servant à fixer le portique XZ à la base sont pré-insérées dans 
le profilé, utilisez la clé Allen fournie pour serrer les vis.
Poussez les extrusions d’aluminium contre l’intérieur de la fente lors du 
serrage des vis.
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ÉTAPE 3

Assemblez le support de bobine comme indiqué sur l'image, puis faites-
le glisser dans les fentes sur le dessus du faisceau supérieur. Utilisez 
ensuite le bouton fourni pour le fixer en place.
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ÉTAPE 4

Connectez les moteurs pas à pas Z et le capteur de voile de filament.
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ÉTAPE 5

ÉTAPE 6

Ajustez le chariot du lit et le chariot du hotend en tournant les écrous 
excentriques avec la clé fournie.

Desserrez les 6 vis qui maintiennent les chariots des deux côtés, puis 
serrez-les UNIQUEMENT lorsque les roues des chariots Z ne reposent 
pas correctement sur les extrusions d'aluminium.
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ÉTALONNAGE
Le Sidewinder X2 est livré avec un capteur de nivellement 
automatique du lit, il effectuera un auto-test lorsque vous allumerez 
l'imprimante, si ce n'est pas le cas, veuillez ne pas continuer et 
vérifier les câbles pour vous assurer qu'ils sont correctement 
installés.

1.	 Accueil de l’imprimante;
2.	 Chauffer le lit et le hotend à 70 ° C et 240 ° C respectivement;
3.	 Allez dans Tools -> Level;
4.	 Faites glisser un morceau de papier A4 entre la buse et la plaque de 

construction;
5.	 Déplacez le hotend aux 4 coins pour répéter l’étape 6;
6.	 Tournez le bouton de nivellement sous le lit le plus proche de la buse 

jusqu’à ce que le morceau de papier glisse, avec juste un peu de 
traînée;

7.	 Dans le menu, allez dans Tools -> More et cliquez sur Auto-Level;
8.	 L’imprimante initialisera la procédure de nivellement automatique 

du lit, attendez qu’elle se termine;
9.	 Cliquez sur EEPROM Save;
10.	Ne procédez comme suit que si la buse raye la plaque de construction 

ou si la buse est trop éloignée de la plaque de construction;
11.	Chauffer le lit et le hotend à 70 ° C et 240 ° C respectivement;
12.	Allez dans Tools -> More -> Z = 0;
13.	La buse se déplacera vers le centre et à une hauteur de 0;
14.	Faites glisser à nouveau le papier A4 entre la buse et le lit, utilisez les 

boutons +0,025 et -0,025 pour ajuster la distance de la buse à partir 
de la plaque de construction jusqu’à ce que le morceau de papier 
glisse, avec juste un peu de traînée;

15.	Cliquez sur EEPROM Save une fois que vous êtes satisfait du 
glissement sur le papier A4;

16.	Répétez les étapes 2 à 9;
17.	Pour activer la compensation pour la mise à niveau automatique, 

ajoutez M420 S1 Z10 après G28 au démarrage du Gcode.
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PRÉPARATION DU LOGICIEL DE TRANCHAGE
Cette imprimante fonctionne avec la plupart des logiciels de 
découpage comme Slic3r, Cura, Simplify3D, etc. Mais nous allons 
aller en détail pour le logiciel Cura et vous dire comment le 
configurer pour que vous puissiez faire votre première impression. 
Tout d'abord, veuillez télécharger le logiciel depuis leur site officiel.

Après l'installation et le démarrage du logiciel, vous devriez voir 
l'écran suivant, continuez jusqu'à ce que vous voyiez Ajouter une 
page d'imprimante:
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Dans Ajouter une imprimante hors réseau, faites défiler jusqu'à 
Custom et choisissez Custom FFF Printer, puis tapez Artillery 
Sidewinder X2 dans Nom de l'imprimante. Cliquez ensuite sur le 
bouton Ajouter.

Réglez X (Largeur), Y (Profondeur) sur 300, Z (Hauteur) sur 400. 
Assurez-vous que le Plateau chauffant est coché.
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Changer le Diamètre du matériau compatible à 1,75

Faites glisser et déposez le fichier STL (ou un autre format pris en 
charge) dans le slicer ou chargez le fichier modèle avec Fichier -> 
Ouvrir le(s) fichier(s)...
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Dans la liste déroulante Profil, choisissez le profil préféré.

Cliquez sur le bouton Slice.
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Vous pouvez cliquer sur Enregistrer sur un lecteur amovible (si 
la carte mémoire est détectée) ou sur le bouton Enregistrer sous 
Fichier pour enregistrer le fichier découpé sur la carte mémoire.

Enregistrez le fichier sur la carte mémoire pour l'impression.
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Insérez la clé USB / la carte mémoire dans l'imprimante puis 
cliquez sur PRINT.

Choisissez le fichier que vous souhaitez imprimer.
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Cliquez sur Confirm et l'impression devrait commencer.
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CARACTÉRISTIQUES
IMPRESSION
Technologie d'impression: modélisation des dépôts fondus

Volume de construction: 300x300x400 mm  
(11,8x11,8x15,7 pouces)

Résolution de couche: 100 à 300 microns
Diamètre du filament: 1,75 mm (0,069 pouces)
Diamètre de la buse: 0,4 mm (0,015 pouces)
Type de fichier d'impression: Gcode
Compatibilité matérielle: PLA, PETG, TPU

DIMENSIONS ET POIDS
Dimensions du produit: 550x470x730 mm (21,7x18,5x28,7 pouces)
Boîte d'expédition: 668x508x310 mm (26,3x20,0x12,2 pouces)
Poids de l'imprimante: 12,9 kg (28,4 livres)
Poids d'expédition: 16 kg (35,3 livres)

ÉLECTRIQUE
Exigences d'alimentation: 110V/220V, 350W
Connectivité: Carte mémoire, clé USB, USB

MÉCANIQUE
Construction: Aluminum, ABS
Surface de construction: Verre + plaque d'aluminium

Moteurs pas à pas: Angle de pas de 1,8 ° avec micro-
pas de 1/256

XY Précision de positionnement: 10 microns
Z Précision de positionnement: 100 microns
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CONTACT
Soutien desk.zoho.com/portal/evnovo/en/newticket

Chez Artillery, nous sommes fiers d'offrir un 
support client expert, réactif et amical aux 
clients du monde entier. Si vous avez besoin 
d'aide pour résoudre un problème avec votre 
imprimante 3D Artillery, visitez l'adresse Web 
ci-dessus pour soumettre un ticket.

Ventes ytcz@artillery3d.com
Pour en savoir plus sur les autres produits 
d'artillerie, veuillez envoyer un courriel à 
l'adresse ci-dessus.

Retour 
d'information

ytcz@artillery3d.com
Pour des questions d'ordre général ou pour 
nous dire ce que vous pensez, envoyez un 
e-mail à l'adresse ci-dessus. Nous adorons 
vous entendre.
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LEGGIMI PRIMA
LEGGETE QUESTO MANUALE COMPLETAMENTE PRIMA 
DI ASSEMBLARE E ACCENDERE LA VOSTRA STAMPANTE!

PERICOLI E AVVERTENZE
La stampante 3D Artillery Sidewinder X2 ha parti motorizzate e 
riscaldate. Quando la stampante è in funzione, essere sempre 
consapevoli dei possibili pericoli.

PERICOLO DI SCOSSE ELETTRICHE
Non aprire mai l'alloggiamento dell'elettronica della stampante 
mentre la stampante è accesa. Prima di rimuovere il pannello di 
accesso, spegnere sempre la stampante e scollegare il cavo di 
alimentazione CA.

PERICOLO DI USTIONI
Non toccare mai l'ugello dell'estrusore, il blocco riscaldatore o il 
letto riscaldato senza prima aver spento l'hotend e il letto riscaldato 
e aver lasciato raffreddare completamente. L'hotend e il letto 
riscaldato possono impiegare fino a venti minuti per raffreddarsi 
completamente. Inoltre, non toccare mai i filamenti estrusi di 
recente. Il filamento può attaccarsi alla pelle e provocare ustioni.

PERICOLO D’INCENDIO
Non lasciare mai materiali o liquidi infiammabili sopra o vicino alla 
stampante quando è accesa o in funzione. L’acetone liquido ei vapori 
sono estremamente infiammabili.

RISCHIO DI PIZZICAMENTO
Quando la stampante è in funzione, fare attenzione a non mettere mai 
le dita nelle parti in movimento, comprese le cinghie, le pulegge, gli 
ingranaggi, le ruote o le viti.

CARICA STATICA
Assicurarsi di collegarsi a terra prima di toccare la stampante, in 
particolare i componenti elettronici. Le cariche elettrostatiche possono 
danneggiare i componenti elettronici. Per radicarti, tocca una fonte con 
messa a terra.

AVVISO DI ETÀ
Per gli utenti di età inferiore ai 18 anni, si consiglia la supervisione di un 
adulto. Attenzione ai rischi di soffocamento intorno ai bambini.
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LEGALE
GARANZIA DI PRODOTTO

La stampante 3D Artillery Sidewinder X2 è coperta da una garanzia 
limitata. Per i termini e le condizioni, vedere https://desk.zoho.
com/portal/evnovo/en/kb/articles/evnovo-limited-warranty

DISPOSIZIONI GENERALI
Tutte le informazioni in questo manuale utente (“Manuale”) 
sono soggette a modifiche in qualsiasi momento senza preavviso 
e vengono fornite solo per comodità. Shenzhen Yuntuchuangzhi 
Technology Co., Ltd. e le nostre rispettive affiliate e fornitori 
(“Artillery”) si riserva il diritto di modificare o rivedere il presente 
Manuale a sua esclusiva discrezione e in qualsiasi momento e non 
si impegna a fornire tali modifiche, aggiornamenti, miglioramenti, 
o altre aggiunte a questo Manuale in modo tempestivo o del 
tutto. Accetti di essere vincolato da eventuali modifiche e / o 
revisioni. Contatta il team di supporto dell’Artillery per informazioni 
aggiornate.

PROPRIETÀ INTELLETTUALE
Il design di questo manuale e tutto il testo, la grafica, le informazioni, 
i contenuti e altro materiale sono protetti da copyright e altre leggi. 
I contenuti sono copyright 2021 Artillery. Tutti i diritti riservati. Alcuni 
marchi, nomi commerciali e loghi (i “Marchi”) utilizzati in questo 
Manuale sono marchi registrati e non registrati, nomi commerciali 
di Artillery e delle sue affiliate. Nulla di quanto contenuto in questo 
Manuale concede o deve essere interpretato come concessione, 
implicitamente, preclusione o altro, di qualsiasi licenza o diritto 
di utilizzo senza il permesso scritto di Artillery. Qualsiasi utilizzo 
non autorizzato di qualsiasi informazione, materiale o Marchio 
può violare le leggi sul copyright, le leggi sui marchi, le leggi sulla 
privacy e la pubblicità e / o altre leggi e regolamenti.
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ESCLUSIONI DI RESPONSABILITÀ
L’Artillery non garantisce l’accuratezza o la completezza delle 
informazioni, dei prodotti o dei servizi forniti da o attraverso questo 
Manuale e non si assume alcuna responsabilità per eventuali 
inesattezze tipografiche, tecniche o di altro tipo in questo Manuale, 
fornito “così com’è” e senza o garanzie implicite di qualsiasi 
tipo, comprese garanzie di commerciabilità, idoneità per uno 
scopo particolare o non violazione della proprietà intellettuale. 
In relazione al tuo utilizzo di questo Manuale, l’Artillery non sarà 
responsabile nei tuoi confronti per eventuali danni, siano essi diretti, 
economici, commerciali, speciali, consequenziali, incidentali, 
esemplari o indiretti, anche se l’Artillery è stata informata della 
possibilità di tali danni, inclusi, senza limitazione, perdita di entrate 
o guadagni aziendali, perdita di dati o perdita di profitti. Artillery 
non si assume alcuna responsabilità, né sarà ritenuta responsabile, 
per eventuali danni a, o virus o malware che possono infettare il tuo 
computer, apparecchiature di telecomunicazione o altre proprietà 
causate o derivanti dal download di qualsiasi informazione o 
materiale relativo al presente Manuale. Le suddette esclusioni non 
si applicano nella misura proibita dalla legge, fare riferimento alle 
leggi locali per tali divieti.
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LETTERA DI ARTILLERY
Caro cliente, 

Grazie per aver scelto la stampante 3D Artillery Sidewinder X2.

Questa guida ti guiderà attraverso l'assemblaggio e la prima 
esecuzione della stampante. In caso di problemi durante 
l'assemblaggio, contattare il nostro servizio clienti o visitare il nostro 
gruppo Facebook ufficiale all'indirizzo:

https://www.facebook.com/groups/artilleryswx2/ 

Per una politica di garanzia dettagliata, visita

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty 

Per assistenza, inviare un'e-mail a support@artillery3d.com 
o visita la nostra pagina di biglietteria all'indirizzo

https://desk.zoho.com/portal/evnovo/newticket 

Oppure puoi visitare il nostro gruppo Facebook all'indirizzo

https://www.facebook.com/artillery3d

Saluti,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Data ultimo aggiornamento: 6 agosto 2021
Questo manuale è aggiornato alla data di stampa,
in caso di dubbio fare riferimento alla versione elettronica.
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LISTA DI CONTROLLO DEGLI ACCESSORI
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PASSO 2

PASSO 1

ASSEMBLAGGIO STAMPANTE

Allineare il gantry XZ alla base, assicurarsi che il connettore sia 
perfettamente allineato al connettore femmina sulla base.

Le viti M5 utilizzate per fissare il portale XZ alla base sono preinserite 
nell’estrusione, utilizzare la chiave a brugola in dotazione per serrare 
le viti.
Spingere i profilati di alluminio contro l’interno dello slot quando si ser-
rano le viti.
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PASSO 3

Montare il supporto per bobina come mostrato nell'immagine, quindi 
farlo scorrere nelle fessure sulla parte superiore della trave superiore. 
Quindi utilizzare la manopola in dotazione per fissarlo in posizione.
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PASSO 4

Collegare i motori passo-passo Z e il sensore di eccentricità del 
filamento.
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PASSO 5

PASSO 6

Regolare il carrello del letto e il carrello dell'hotend ruotando i dadi 
eccentrici con la chiave in dotazione.

Allentare le 6 viti che fissano i carrelli su entrambi i lati, quindi serrarle 
SOLO quando le ruote sui carrelli Z non sono posizionate correttamente 
sui profilati in alluminio.
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LIVELLAMENTO DELLA PIASTRA DI COSTRUZIONE
Sidewinder X2 viene fornito con il sensore di livellamento automatico 
del letto, eseguirà un autotest all'accensione della stampante, in 
caso contrario, non procedere e controllare i cavi per assicurarsi che 
siano posizionati correttamente.

1.	 Home la stampante 3D;
2.	 Riscaldare il letto e l’hotend rispettivamente a 70 ° C e 240 ° C;
3.	 Vai a Tools -> Level;
4.	 Far scorrere un pezzo di carta A4 tra l’ugello e la piastra di costruzione;
5.	 Spostare l’hotend su tutti e 4 gli angoli per ripetere il passaggio 6;
6.	 Ruotare la manopola di livellamento sotto il letto più vicino all’ugello 

fino a quando il pezzo di carta non scivola, con appena un po ‘di 
trascinamento;

7.	 Dal menu, vai su Tools -> More e fai clic su Auto-Level;
8.	 La stampante inizializzerà la procedura di livellamento automatico 

del letto, attenderà fino al termine;
9.	 Fare clic su EEPROM Save;
10.	Eseguire quanto segue solo se l’ugello graffia sulla piastra di 

costruzione o l’ugello è troppo lontano dalla piastra di costruzione;
11.	Riscaldare il letto e l’hotend rispettivamente a 70 ° C e 240 ° C;
12.	Vai a Tools -> More -> Z = 0;
13.	L’ugello si sposterà al centro e ad altezza 0;
14.	Far scorrere di nuovo la carta A4 tra l’ugello e il letto, utilizzare i 

pulsanti +0,025 e -0,025 per regolare la distanza dell’ugello dalla 
piastra di costruzione fino a quando il pezzo di carta non scivola, 
con solo un po ‘di trascinamento;

15.	Fai clic su EEPROM Save una volta che sei soddisfatto del 
trascinamento sulla carta A4;

16.	Ripeti i passaggi da 2 a 9;
17.	Per abilitare la compensazione per il livellamento automatico, 

aggiungere M420 S1 Z10 dopo G28 all’avvio del Gcode.
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PREPARAZIONE DEL SOFTWARE DI AFFETTATURA
Questa stampante funziona con la maggior parte dei software di 
slicing come Slic3r, Cura, Simplify3D, ecc. Ma andremo in dettaglio 
per il software Cura e ti diremo come configurarlo in modo da poter 
fare la tua prima stampa. Innanzitutto, scarica il software dal loro 
sito ufficiale.

Dopo l'installazione e l'avvio del software, dovresti vedere la 
seguente schermata, continuare fino a visualizzare la pagina 
Aggiungi una stampante:
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In Aggiungi una stampante non in rete, scorri verso il basso fino a 
Custom e scegli Custom FFF Printer e digita Artillery Sidewinder X2 
in Nome stampante. Quindi fare clic sul pulsante Aggiungi.

Imposta X (Larghezza), Y (Profondità) su 300, Z (Altezza) su 400. 
Assicurati che il Piano riscaldato sia selezionato.
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Modificare il Diametro del materiale compatibile in 1,75

Trascina e rilascia il file STL (o un altro formato supportato) 
nell'affettatrice o carica il file del modello con File -> Apri file... 
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Dal menu a discesa Profilo, scegli il profilo preferito.

Fare clic sul pulsante Sezionamento.
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È possibile fare clic su Salva su unità rimovibile (se viene rilevata la 
scheda di memoria) o sul pulsante Salvare su File per salvare il file 
suddiviso in porzioni sulla scheda di memoria.

Salvare il file sulla scheda di memoria per la stampa.



- 118 -

Inserire l'unità USB / scheda di memoria nella stampante, quindi 
fare clic su PRINT.

Scegli il file che desideri stampare.
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Fare clic su Confirm e la stampa dovrebbe iniziare.
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SPECIFICHE
STAMPA
Tecnologia di stampa: modellazione a deposizione fusa
Volume di costruzione: 300x300x400 mm (11,8x11,8x15,7 pollici)
Risoluzione del livello: 100-300 micron
Diametro del filamento: 1,75 mm (0,069 pollici)
Diametro ugello: 0,4 mm (0,015 pollici)
Tipo di file di stampa: Gcode
Compatibilità materiale: PLA, PETG, TPU

DIMENSIONI E PESO
Dimensioni del prodotto: 550x470x730 mm (21,7x18,5x28,7 pollici)
Scatola di spedizione: 668x508x310 mm (26,3x20,0x12,2 pollici)
Peso della stampante: 12,9 kg (28,4 libbre)
Peso della Spedizione: 16 kg (35,3 libbre)

ELETTRICA
Requisiti di alimentazione: 110V/220V, 350W
Connettività: Scheda di memoria, chiavetta USB, USB

MECCANICA
Costruzione: Alluminio, ABS
Costruisci superficie: Piatto in vetro + alluminio

Motori passo-passo: Angolo di passo di 1,8 ° con 
micro-passo 1/256

XY Posizionamento di precisione: 10 micron
Z Posizionamento di precisione: 100 micron
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CONTATTO
Supporto desk.zoho.com/portal/evnovo/en/newticket

In Artillery, siamo orgogliosi di offrire 
un'assistenza clienti esperta, reattiva e 
amichevole ai clienti di tutto il mondo. Se hai 
bisogno di aiuto per risolvere un problema con 
la tua stampante 3D Artillery, visita l'indirizzo 
web sopra per inviare un ticket.

I saldi ytcz@artillery3d.com
Per conoscere altri prodotti di Artillery, inviare 
un'e-mail all'indirizzo sopra.

Risposta ytcz@artillery3d.com
Per domande generali o per dirci cosa hai in 
mente, invia un'email all'indirizzo sopra. Ci 
piace sentire la tua opinione.
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ПРЕДУПРЕЖДЕНИЯ О БЕЗОПАСНОСТИ
ПОЛНОСТЬЮ ПРОЧИТАЙТЕ ДАННОЕ РУКОВОДСТВО 
ПЕРЕД СБОРКОЙ И ПОДКЛЮЧЕНИЕМ ПРИНТЕРА!

ОПАСНОСТИ И ПРЕДУПРЕЖДЕНИЯ
3D-принтер Artillery Sidewinder X2 имеет моторизованные 
и подогреваемые детали. Когда принтер работает, всегда 
помните о возможных опасностях.

ОПАСНОСТЬ ПОРАЖЕНИЯ ЭЛЕКТРИЧЕСКИМ ТОКОМ
Никогда не открывайте отсек электроники принтера, когда он 
включен. Перед снятием защитной панели всегда выключайте 
принтер и отсоединяйте шнур питания переменного тока.

ОПАСНОСТЬ ОЖОГА
Никогда не прикасайтесь к соплу экструдера, нагревательному 
блоку или нагреваемому слою, не выключив предварительно 
нагревательный элемент и нагретый слой и не дав ему полностью 
остыть. Для полного остывания горячей и подогреваемой 
кровати может потребоваться до двадцати минут. Кроме того, 
никогда не касайтесь недавно экструдированных волокон. 
Нить может прилипнуть к коже и вызвать ожог.

ПОЖАРООПАСНОСТЬ
Никогда не оставляйте легковоспламеняющиеся материалы или 
жидкости на принтере или рядом с ним, когда он включен или 
работает. Жидкий ацетон и его пары легко воспламеняются.

ОПАСНОСТЬ ЗАЩЕМЛЕНИЯ
Во время работы принтера будьте осторожны, никогда не касайтесь 
пальцами движущихся частей, включая ремни, шкивы, шестерни, 
колеса или ходовые винты.

СТАТИЧЕСКИЙ ЗАРЯД
Обязательно заземлите себя перед тем, как прикасаться к 
принтеру, особенно к электронике. Электростатический заряд 
может повредить электронные компоненты. Чтобы заземлить 
себя, прикоснитесь к заземленному источнику.

ПРЕДУПРЕЖДЕНИЕ О ВОЗРАСТЕ
Для пользователей младше 18 лет рекомендуется наблюдение 
взрослых. Остерегайтесь удушья рядом с детьми.
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ЮРИДИЧЕСКИЙ
ГАРАНТИЯ НА ПРОДУКТ

На 3D-принтер Artillery Sidewinder X2 распространяется 
ограниченная гарантия. Условия использования см. На странице  
https://desk.zoho.com/portal/evnovo/en/kb/articles/evnovo-
limited-warranty.

ОБЩИЕ ПОЛОЖЕНИЯ
Вся информация в этом руководстве пользователя 
(«Руководство») может быть изменена в любое время без 
предварительного уведомления и предоставляется только 
для удобства. Компания Shenzhen Yuntuchuangzhi Technology 
Co., Ltd. и наши соответствующие аффилированные лица 
и поставщики («Артиллерия») оставляют за собой право 
изменять или пересматривать настоящее Руководство по 
своему усмотрению и в любое время и не берет на себя 
никаких обязательств по предоставлению каких-либо таких 
изменений, обновлений, улучшений, или другие дополнения к 
этому Руководству своевременно или вообще. Вы соглашаетесь 
с любыми изменениями и / или исправлениями. Свяжитесь с 
группой артиллерийской поддержки для получения последней 
информации.

ИНТЕЛЛЕКТУАЛЬНАЯ СОБСТВЕННОСТЬ
Дизайн этого Руководства и весь текст, графика, информация, 
контент и другие материалы защищены законом об авторском 
праве и другими законами. Авторские права на содержание 
принадлежат 2021 Artillery. Все права защищены. Некоторые 
товарные знаки, торговые наименования и логотипы 
(«Знаки»), используемые в данном Руководстве, являются 
зарегистрированными и незарегистрированными товарными 
знаками, торговыми наименованиями компании Artillery и ее 
дочерних компаний. Ничто, содержащееся в данном Руководстве, 
не предоставляет и не должно толковаться как предоставление, 
косвенно, эстоппеля или иным образом, какой-либо лицензии 
или права на использование без письменного разрешения 
Artillery. Любое несанкционированное использование любой 
информации, материалов или Знаков может нарушать законы 
об авторском праве, законы о товарных знаках, законы о 
конфиденциальности и публичности и / или другие законы и 
постановления.
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ОТКАЗ ОТ ОТВЕТСТВЕННОСТИ
Artillery не гарантирует точность или полноту информации, 
продуктов или услуг, предоставляемых настоящим Руководством 
или посредством него, и не несет ответственности за любые 
типографские, технические или другие неточности в этом 
Руководстве, которое предоставляется «как есть» и без каких-
либо явных или подразумеваемые гарантии любого рода, 
включая гарантии товарной пригодности, пригодности для 
определенной цели или ненарушения прав интеллектуальной 
собственности. В связи с использованием вами настоящего 
Руководства Artillery не несет ответственности перед вами 
за какие-либо убытки, будь то прямые, экономические, 
коммерческие, особые, косвенные, случайные, образцовые 
или косвенные убытки, даже если Artillery была уведомлена о 
возможности таких убытков, включая, помимо прочего, потерю 
коммерческого дохода или прибылей, потерю данных или 
упущенную выгоду. Artillery не несет ответственности и не будет 
нести ответственности за любой ущерб или любые вирусы 
или вредоносные программы, которые могут заразить ваш 
компьютер, телекоммуникационное оборудование или другое 
имущество, вызванные или возникшие в результате загрузки 
вами любой информации или материалов, связанных с этим 
Руководством. Вышеупомянутые исключения не применяются 
в той степени, в которой это запрещено законом, пожалуйста, 
обратитесь к местным законам, чтобы узнать о любых таких 
запретах.
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ПИСЬМО ИЗ АРТИЛЛЕРИИ
Уважаемый клиент, 

Благодарим вас за выбор 3D-принтера Artillery Sidewinder X2.

Это руководство проведет вас через сборку и первый запуск 
принтера. Если у вас возникли проблемы во время сборки, 
обратитесь в нашу службу поддержки клиентов или посетите нашу 
официальную группу в Facebook по адресу:

https://www.facebook.com/groups/artilleryswx2/ 

Для получения подробной информации о гарантийных 
обязательствах посетите

https://desk.zoho.com/portal/evnovo/kb/articles/evnovo-limited-
warranty 

Для получения поддержки отправьте электронное письмо на 
адрес support@artillery3d.com 
или посетите нашу страницу продажи билетов по адресу

https://desk.zoho.com/portal/evnovo/newticket 

Или вы можете посетить нашу группу в Facebook по адресу

https://www.facebook.com/artillery3d

С уважением,

Artillery

Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Дата последнего обновления: 6 августа 2021
Настоящее руководство обновлено на дату печати, 
в случае сомнений обратитесь к электронной версии.
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КОНТРОЛЬНЫЙ СПИСОК ПРИНАДЛЕЖНОСТЕЙ



- 128 -

ШАГ 2

ШАГ 1

СБОРКА

Совместите портал XZ с основанием, убедитесь, что разъем 
идеально совмещен с гнездовым разъемом на основании.

Винты M5, используемые для крепления портала XZ к основанию, 
предварительно вставлены в экструзионный профиль. Для 
затяжки винтов используйте прилагаемый шестигранный ключ.
При затягивании винтов прижмите алюминиевые профили внутрь 
паза.
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ШАГ 3

Соберите держатель катушки, как показано на рисунке, затем 
вставьте его в прорези в верхней части верхней балки. Затем 
используйте ручку из комплекта поставки, чтобы зафиксировать 
ее на месте.
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ШАГ 4

Подключите шаговые двигатели Z и датчик биения нити накала.
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ШАГ 5

ШАГ 6

Отрегулируйте каретку станины и подвижную каретку, поворачивая 
эксцентриковые гайки с помощью прилагаемого гаечного ключа.

Ослабьте 6 винта, удерживающие каретки с обеих сторон, затем 
затяните их ТОЛЬКО, когда колеса кареток Z не сидят должным 
образом на алюминиевых профилях.
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ВЫРАВНИВАНИЕ РАБОЧЕЙ ПЛАСТИНЫ
Sidewinder X2 поставляется с датчиком автоматического 
выравнивания станины, он выполнит самотестирование 
при включении принтера, если этого не произойдет, не 
продолжайте и проверьте кабели, чтобы убедиться, что они 
правильно установлены.

1.	 Домашний 3D-принтер;
2.	 Нагрейте кровать и хотенд до 70 ° C и 240 ° C соответственно;
3.	 Перейдите в Tools -> Level;
4.	 Вставьте лист бумаги формата A4 между соплом и рабочим 

столом;
5.	 Переместите hotend ко всем 4 углам, чтобы повторить шаг 6;
6.	 Поворачивайте ручку выравнивания под кроватью, ближайшей 

к соплу, пока лист бумаги не начнет скользить, с небольшим 
усилием;

7.	 В меню выберите Tools -> More и нажмите Auto-Level;
8.	 Принтер запустит процедуру автоматического выравнивания 

станины, дождитесь ее завершения;
9.	 Нажмите EEPROM Save;
10.	Выполните следующие действия, только если сопло царапает 

рабочую пластину или сопло находится слишком далеко от 
рабочей пластины;

11.	Нагрейте кровать и хотенд до 70 ° C и 240 ° C соответственно;
12.	Зайдите в Tools -> More -> Z = 0;
13.	Сопло переместится к центру на нулевую высоту;
14.	Снова вставьте бумагу формата A4 между соплом и платформой, 

используйте кнопки +0,025 и -0,025, чтобы отрегулировать 
расстояние сопла от рабочей пластины до тех пор, пока лист 
бумаги не скользит, с небольшим усилием;

15.	Нажмите EEPROM Save, когда будете довольны перетаскиванием 
листа A4;

16.	Повторите шаги 2–9;
17.	Чтобы включить компенсацию автоматического выравнивания, 

добавьте M420 S1 Z10 после G28 в стартовом Gcode.
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ПОДГОТОВКА ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ ДЛЯ НАРЕЗКИ

Этот принтер работает с большинством программ нарезки, таких 
как Slic3r, Cura, Simplify3D и т. Д. Но мы подробно рассмотрим 
программное обеспечение Cura и расскажем, как его настроить, 
чтобы вы могли сделать свою первую печать. Сначала загрузите 
программное обеспечение с их официального сайта.

После установки и запуска программного обеспечения вы 
должны увидеть следующий экран, продолжайте, пока не 
увидите страницу Добавить принтер:
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В окне Добавить принтер, не подключенный к сети прокрутите 
вниз до пункта Artillery и выберите Sidewinder X1 и введите 
Artillery Sidewinder X2 в поле Имя принтера. Затем нажмите 
кнопку Добавить.

Установите X (Ширина), Y (Глубина) как 300, Z (Высота) как 400. 
Убедитесь, что установлен флажок Нагреваемый стол.
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Измените диаметр совместимого материала на 1,75

Перетащите файл STL (или другой поддерживаемый формат) 
в слайсер или загрузите файл модели с помощью файл -> 
Открыть файл (ы)...
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В раскрывающемся списке Профиль выберите 
предпочтительный профиль.

Нажмите кнопку Hapeзка на слои.
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Вы можете нажать Сохранить на съемный диск (если 
обнаружена карта памяти) или Сохранить в файл, чтобы 
сохранить разрезанный файл на карту памяти.

Сохраните файл на карту памяти для печати.
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Вставьте USB-накопитель / карту памяти в принтер и нажмите 
PRINT.

Выберите файл, который хотите распечатать.
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Нажмите Confirm, и печать должна начаться.
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ХАРАКТЕРИСТИКИ
ПЕЧАТЬ

Технология печати: Моделирование наплавленного 
осаждения

Объем сборки: 300x300x400 мм  
(11,8x11,8x15,7 дюйма)

Разрешение слоя: 100-300 мкм
Нить: 1,75 мм (0,069 дюйма)
Диаметр сопла: 0,4 мм (0,015 дюйма)
Тип файла для печати: Gcode
Совместимость материалов: PLA, PETG, TPU

РАЗМЕР И ВЕС
Размеры продукта: 550x470x730 мм (21,7x18,5x28,7 дюйма)
Транспортная коробка: 668x508x310 мм (26,3x20,0x12,2 дюйма)
Вес принтера: 12,9 кг (28,4 фунта)
Вес с упаковкой: 16 кг (35,3 фунта)

ЭЛЕКТРИЧЕСКИЙ
Требования к питанию: 110 В / 220 В, 350 Вт
Связь: Карта памяти, USB-накопитель, USB

МЕХАНИЧЕСКИЙ
Строительство: Алюминий, АБС
Строить поверхность: Стекло + алюминиевая пластина

Шаговые двигатели: Угол шага 1,8 ° с шагом 1/256 
микрошага

Точность позиционирования 
XY: 10 микрон

Точность позиционирования 
по оси Z: 100 микрон
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КОНТАКТ 
Поддержка desk.zoho.com/portal/evnovo/en/newticket

В Artillery мы гордимся тем, что предлагаем 
квалифицированную, отзывчивую и 
дружелюбную поддержку клиентов по всему 
миру. Если вам нужна помощь в решении 
проблемы с вашим 3D-принтером Artillery, 
посетите веб-адрес выше, чтобы отправить 
заявку.

Продажи ytcz@artillery3d.com
Чтобы узнать о других продуктах 
артиллерии, отправьте электронное письмо 
по указанному выше адресу.

Обратная связь ytcz@artillery3d.com
Чтобы задать общие вопросы или сообщить 
нам, что у вас на уме, отправьте электронное 
письмо по указанному выше адресу. Мы 
рады получить от вас известие.



Shenzhen Yuntu Chuangzhi Technology Co., Ltd.
Address: Rm 1601-02, Bldg 11, Cloud Park 2nd Phase, 
2018 Xuegang Lu, Bantian Sub-district, Longgang District, 
Shenzhen 518129, China
Email: ytcz@artillery3d.com
Website: www.artillery3d.com


